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CONTACTING THE SONARDYNE SUPPORT TEAM 
24-hour Emergency Telephone Helpline: +44 (0) 1252 877600 

The Sonardyne 24-hour helpline is answered at the UK Headquarters during normal office hours 
(08:00 to 17:00 GMT). Outside these hours, your call is automatically transferred to an agency, 
which logs the details of your emergency and alerts the appropriate Sonardyne personnel. 

Our aim is to make sure emergency requests are dealt with immediately during office hours, and 
are responded to within 30 minutes at all other times. 

Please note the helpline is for emergency use only. 

If you require NON-EMERGENCY product support, please contact your nearest Sonardyne office.  
Alternatively, contact the Sonardyne Head Office: 

Blackbushe Business Park 

Yateley 

Hampshire 

GU46 6GD 

England 

Telephone: +44 (0) 1252 872288 

Fax: +44 (0) 1252 876100 

Email: support@sonardyne.com 

NOTE 

 Email and telephone support is available during normal office hours (08:00 to 17:00 
GMT). 

 

mailto:support@sonardyne.com
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SECTION 1 – INTRODUCTION 

1. Introduction 
This Operation Manual describes the safe installation and operation of the iWAND 6G Configurator 
Software. The information and procedures within this manual are based on Sonardyne’s experience 
and knowledge. 

To make sure the safety of the installer and operator is maintained it is important that all Warnings, 
Cautions and Safety Section in this manual, and the Warnings, Cautions and Safety Section of any 
additional manuals are read and understood. 

1.1 Related Publications 

To make sure the system is operated safely, a Safety Manual is supplied with this Operation 
Manual. It is important the Safety Manual is read and understood before proceeding with any 
activity on the equipment. 

The related publications are: 

Table 1-1 – Related Publications 

Publication Title 

Safety Manual Safety Manual 
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SECTION 2 – SAFETY 

2. Introduction 
Before any activity is carried out on this system, it is recommended all Warnings and Cautions in 
hardware manual are read and understood.  

It is recommended the operator complies with the Health and Safety Regulations applicable to the 
vessel and the region before operating any equipment. 

Operators and service personnel must be familiar with the normal operating and safety procedures 
for Subsea Equipment. 

Documentation must be consulted whenever a  Warning symbol is found on the equipment, in 
order to determine the nature of the potential hazard and any actions which must be taken. 

If the equipment is used in a manner not specified by the manufacturer, the protection provided by 
the equipment may be impaired. 

The safety of any system incorporating this equipment is the responsibility of the assembler of the 
system. 
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SECTION 3 – TECHNICAL DESCRIPTION 

3. Introduction 
This manual is intended to provide users with guidance on the installation and operation of 
Sonardyne’s iWAND 6G Configurator Software for use with the 8315 iWAND. 

3.1 Description 

The iWAND 6G Configurator Software allows monitoring and configuration of Sonardyne’s 6G 
products, without the need to directly connect the instrument to a PC. 

By placing the acoustic transducer of the iWAND next to the transducer of the instrument, the 
iWAND can either gather or transmit settings to and from the instrument. The iWAND 6G 
Configurator Software can then be used to view, verify or modify the instrument configuration. 

3.2 iWAND 6G Configurator Instrument Status 

The iWAND 6G Configurator status page provides a clear and concise overview of the 6G 
instrument. The status page is separated into specific areas: 

• Image of the 6G instrument 

• Identity 

• Firmware version 

• Battery and Life Estimation 

• Features 

Figure 3-1 – Status Tab 
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3.2.1 Image 

Refer to Figure 3-2. The image is a visual representation of the instrument. 

Figure 3-2 – Image 

 
 

3.2.2 Identity 

Refer to Figure 3-3. The identity includes the serial number of the instrument; the Unique Identifier 
(UID) (which should match the number listed in the asset or history list); the Depth Rating; and the 
type of transducer fitted. 

Figure 3-3 – Identity of the Instrument 
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3.2.3 Firmware Version 

Refer to Figure 3-4. Depending on the type of instrument the Firmware Versions installed in the 
instrument will be listed. Refer to the Sonardyne website (www.sonardyne.com) for a list of the 
latest firmware versions, or contact the Sonardyne Support Team for the latest updates. 

Figure 3-4 – Firmware Versions 

 
 

3.2.4 Battery and Life Estimation 

Refer to Figure 3-5. The Battery and Life Estimation provides a visual incremental measurement of 
battery life. As battery power decreases the visual counter changes colour to red to indicate low 
power. Displayed next to the battery life display is the type of battery fitted, the power and 
percentage of usage remaining. 

Figure 3-5 – Battery and Life Estimation 

 
 

http://www.sonardyne.com/
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Refer to Figure 3-6. Hovering the cursor over the battery image will reveal more battery information 
including instantaneous currents and battery temperature. 

Figure 3-6 – Battery Information 

 
 

3.2.5 Features 

Refer to Figure 3-7. The Features area displays icons to represent all sensors and other 
components added to the instrument. 

Figure 3-7 – Features 
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Refer to Figure 3-8. By hovering the cursor over a particular icon more information about the 
feature is revealed, such as the accuracy of the instrument and its range of values. 

Figure 3-8 – Sound Velocity Values 

 
 

3.3 Instrument Configuration 

Refer to Figure 3-9. The configuration tab details the full operational setup of the instrument and 
allows changes to that setup. 

Figure 3-9 – Configuration Tab 
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3.4 Instrument Traffic Light Indication 

Next to each instrument listed is a coloured disc, or traffic light. These discs are coloured either 
Green, Amber or Red to indicate the different stages of configuration – refer to Figure 3-10. 

Figure 3-10 – Traffic Light Indication 

 
 

• Green – The green indicator is displayed to confirm the instrument is up to date and 
synchronized with the configuration displayed in the iWAND 6G Configurator software. 

• Amber – the amber indicator is displayed when configuration changes have been made 
to an instrument on the iWAND 6G Configurator software and these changes have been 
transferred to the iWAND, but not yet transferred to the instrument. 

• Red – The red indicator is displayed when configuration changes have been made to 
an instrument on the iWAND 6G Configurator software but these have not yet been 
transferred to the iWAND. The red indicator should only be visible for a brief moment 
before the information is then transferred to the iWAND if connected to the PC. If the 
iWAND is not connected the indicator will stay red until the iWAND is next connected 
and refreshed. 
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SECTION 4 – INSTALLATION 

4. Pre-Installation Requirements 
The iWAND 6G Configurator software will be supplied on a CD along with the iWAND. To enable 
successful installation and operation of the iWAND 6G Configurator software the following system 
requirements will be needed: 

• Recommended requirements:  Windows 7 

• Minimum Operating requirements: Windows XP SP3 or later, 32 or 64 bit 

• Recommended RAM requirements: 4+GB 

• Minimum RAM requirements:  2GB 

4.1 Installation Process 

For successful installation of the iWAND 6G configurator software proceed as follows: 

1. Insert the iWAND 6G Configurator software CD into the PC. 

2. Refer to Figure 4-1. Locate the software in the CD drive and double click setup.exe to start 
the installation. 

Figure 4-1 – Select setup.exe 

 
 

3. Refer to Figure 4-2. A Sonardyne iWAND 6G Configurator – InstallShield Wizard 
notification screen will appear with a progress bar indicating the files are being extracted from 
the CD. 

Figure 4-2 – Sonardyne iWAND 6G Configurator – InstallShield Wizard 
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4. Refer to Figure 4-3. When all the files have been extracted from the CD, the install wizard will 
notify that it wishes to install the Sonardyne iWAND 6G Configurator software. 

Figure 4-3 – Welcome screen for Sonardyne iWAND 6G Configurator Installation Wizard 

 
 

5. Click Next to continue with the installation process. 

6. Refer to Figure 4-4. A License Agreement window will appear. 

Figure 4-4 – License Agreement Window 

 
 

7. Select “I accept the terms in the license agreement”, then click Next. 
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8. Refer to Figure 4-5. The Wizard will identify the location for the iWAND 6G Configurator file. 
If the suggested location is incorrect select Change to enter a different location. 

Figure 4-5 – File Location 

 
 

9. Click Next to accept the suggested file location. 

10. Refer to Figure 4-6. A Ready to Install the Program window will appear to confirm the 
iWAND 6G Configurator software is to be installed. 

Figure 4-6 – Ready to Install iWAND 6G Configurator Software 

 
 

11. To continue with the installation process click Install. 

NOTE 

 If any changes to the installation are to be made click Back. If the software is not to be 
installed click Cancel. 
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12. Refer to Figure 4-7. The installation of the iWAND 6G Configurator software will begin and a 
progress bar will indicate the speed of the installation. 

Figure 4-7 – Installation Progress of iWAND 6G Configurator 

 
 

13. Refer to Figure 4-8. A window will appear notifying the installation has completed. 

Figure 4-8 – Installation Complete 

 
 

14. Click Finish to accept completion of the installation and to close the installation wizard. 
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SECTION 5 – CONNECTING TO THE iWAND 

5. Connecting the iWAND to the iWAND 6G Configurator 
Software 

Connecting the iWAND to a PC installed with the iWAND 6G Configurator software can be 
achieved by several methods: 

• Bluetooth (available with Windows 7 only) 

• USB connection 

• Serial Port connection 

5.1 Connecting the iWAND using Bluetooth 

When connecting the iWAND to a PC using Bluetooth make sure the Bluetooth on the iWAND is on 
(refer to the iWAND manual UM-8315 for instructions for switching the Bluetooth on). 

Supplied in the transit case with the iWAND is a Belkin Bluetooth dongle. Make sure this is 
connected to a PC USB connection using Bluetooth even if the PC has Bluetooth installed and 
enabled. 

1. Refer to Figure 5-1. Start the iWAND 6G Configurator software by double clicking on the 
desktop icon.  

Figure 5-1 – iWAND 6G Configurator Software icon 

 
 

2. Refer to Figure 5-2. The iWAND 6G Configurator software blank home screen will appear. 

Figure 5-2 – iWAND 6G Configurator software Blank Home Screen 
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3. Refer to Figure 5-3. Select Configuration, then Find Port. 

Figure 5-3 – Find Port 

 
 

4. Refer to Figure 5-4. The Select Active Port window will appear. If both the Bluetooth on the 
PC and the Bluetooth on the iWAND are enabled the software will seek a Bluetooth 
connection. 

Figure 5-4 – Seeking Bluetooth Connection 
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5. Refer to Figure 5-5. When the iWAND Bluetooth has been detected it will appear at the top of 
the list of ports. 

6. Confirm the serial number listed is correct. Click OK to connect to the iWAND. 

Figure 5-5 – iWAND Bluetooth Port Detected 

 
 

7. Refer to Figure 5-6. At the bottom of the screen a Bluetooth icon and notification of 
connection attempts will appear. 

Figure 5-6 – Bluetooth Device Trying to Connect 

 
 

8. Refer to Figure 5-7. If the PC and iWAND Bluetooth connection fails a red dot will appear 
next to the Bluetooth port. 

Figure 5-7 – Bluetooth Connection Timed Out 
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9. Refer to Figure 5-8. An information window will also appear stating the device is unreachable 
and asking if a retry is required. 

Figure 5-8 – Bluetooth Connection Failed Retry Connecting 

 
 

10. Click OK to retry to connect. The PC and iWAND will now retry to connect. 

11. Refer to Figure 5-9. To confirm the PC and iWAND are to be connected by Bluetooth an Add 
a Device window will appear. Check the iWAND serial number is correct then click Next. 

Figure 5-9 – Add a Device 

 
 

12. Refer to Figure 5-10. The iWAND 6G Configurator home page will now appear. A green 
indicator will show the Bluetooth is connected and any data stored in the iWAND will be 
displayed. 

Figure 5-10 – iWAND Connected to the iWAND 6G Configurator software 
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5.2 Connecting the iWAND using a Serial Port or USB Connection 

When connecting to the iWAND using a USB connection, make sure the iWAND is connected to 
the PC using the supplied USB cable. If connecting using the serial RS232 connection make sure a 
serial cross-over cable is used (this is not supplied with the iWAND). 

1. Refer to Figure 5-11. Select Configuration, then Find Port. 

Figure 5-11 – Find Port 

 
 

2. Refer to Figure 5-12. The Select Active Port window will appear. It will state that a Bluetooth 
search has been complete and that it is seeking USB identifiers. 

NOTE 

 The Select Active Port will search for a Bluetooth connection first, if it does not find one 
it will then search for a USB connection. 

Figure 5-12 – Seeking USB Identifiers 
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3. Refer to Figure 5-13. When the Select Active Port has finished searching for all the Ports the 
window will list all possible USB or Serial connection ports and state the port search is 
complete. 

Figure 5-13 – Select Serial or USB Port 

 
 

4. Select the correct port the PC is connected to, then click OK. 

5. Refer to Figure 5-14. The iWAND 6G Configurator software home page will now appear. The 
Serial or USB port will appear at the bottom left of the screen with a green indicator to show 
the connection is complete. Any data stored in the iWAND will now be displayed. 

Figure 5-14 – Serial Port Connection 
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5.3 Adjusting Screen Brightness 

Depending on the environment and working conditions it is possible to alter the brightness of the 
screen to improve visibility. 

1. Refer to Figure 5-15. From the toolbar select View, Brightness Level then one of the 
options: Night, Dim, Day, Bright. 

Figure 5-15 – Adjust Brightness 
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SECTION 6 – OPERATION 

6. Introduction 
The iWAND has been designed to be simple and easy to operate in any environment. For full 
instructions on operation of the iWAND refer to the iWAND manual – UM-8315. 

6.1 Configuring the iWAND using the iWAND 6G Configurator 
Software 

The iWAND time must be set to allow Get Configuration and Set Configuration operations to 
function. If the GPS has been turned off or GPS is not available (so the iWAND time is not set) the 
iWAND time can be set from the PC internal clock from the Configure iWAND screen. The time 
configured on the iWAND will be UTC time which will not necessarily match the local time indicated 
on the PC depending on the time-zone. 

1. Refer to Figure 6-1. To check the iWAND configuration, from the toolbar select 
Configuration then Configure iWAND. 

Figure 6-1 – Configure the iWAND 

 
 

2. Refer to Figure 6-2. In the iWAND configuration parameters window check the Time, GPS 
Set and Offset from PC are all correct. 

Figure 6-2 – iWAND Configuration Parameters 
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3. To set the iWAND clock with the PC clock time, click Synchronise. Click Close to close the 
iWAND Configuration window. 

6.2 Instrument Listing 

When the iWAND is connected to the iWAND 6G Configurator software all items stored in the 
iWAND will be listed and categorised according to History or Asset. Selection of an instrument will 
reveal the last time and date the iWAND interrogated that instrument. 

6.2.1 History Listings 

Refer to Figure 6-3. The history is a list of all instruments stored in the iWAND in chronological 
order starting with the most recent. 

Figure 6-3 – History List 

 
 

6.2.2 Asset Listings 

Refer to Figure 6-4. The asset is a list of all instruments stored on the iWAND in type groups. 

Figure 6-4 – Asset List 
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6.3 Operating the iWAND 6G Configurator Software 

When all information stored in the iWAND has been transferred to the iWAND 6G Configurator 
Software it is possible to view and reconfigure settings of instruments for use in different scenarios 
and operational requirements. 

6.3.1 Finding Equipment 

To find and review any piece of equipment: 

1. Refer to Figure 6-5. Open and extend with the History or Asset list. Select the required 
instrument from the list. 

Figure 6-5 – Instrument Type in Asset List 

 
 

2. Refer to Figure 6-6. Alternatively if the instrument UID is known select the required 
instrument from the Find UID drop down list. 

Figure 6-6 – Find UID Drop Down Selection 

 
 



 
Operation Manual for the iWAND 6G 
Configurator Software 

OM-8315 
Issue A Rev 0 

 

 

Section 6 
24 April 2013 23 

3. Refer to Figure 6-7. Selecting the instrument from the Asset List will display notification of 
when the instrument was last synchronised and if it is up to date. 

Figure 6-7 – Instrument Synchronisation Notification 

 
 

4. Once the instrument has been selected the status tab will appear on the right of the screen 
showing an image of the instrument type (if one is available); the identity of the instrument 
including Serial Number, UID, Depth Rating, and the Transducer type; Firmware Versions; 
Features (including types of sensors fitted and if a release mechanism is fitted); Battery and 
Life Estimation. 

6.3.2 Removing an Instrument from the Listing 

It may be necessary or desirable to remove instrument from the listings. 

1. Refer to Figure 6-8. Right click on the instrument to be removed. In the window select 
Remove. 

Figure 6-8 – Removing Equipment from the Listings 
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2. The instrument is now removed from the listings. 

NOTE 

 This only removes the instrument from the software, if the user reconnects, or retrieves 
data from the iWAND, the information regarding this beacon will reappear. 

6.4 Changing Instrument Configuration 

It is possible to change the configuration of a 6G instrument on the iWAND 6G Configurator 
software. These changes are then transferred to the instrument by the iWAND. 

To change the configuration of an instrument: 

1. Refer to Figure 6-9. Select the instrument to be amended from the asset list. Select the 
Configuration tab. 

Figure 6-9 – Select Configuration Tab 

 
 

6.4.1 Changing the Instrument Task 

Depending on the operational requirements of the instrument, it is possible to change the task. 

1. Select the required operational task from the list: 

• USBL Positioning 

• LBL Positioning 

• Modem 
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2. Refer to Figure 6-10. Using the slide bars in the image, to select the appropriate range 
values for the operational requirements. The software will then assign appropriate power and 
gain levels to the device. 

Figure 6-10 – Select Instrument Task Requirements 

 
 

6.4.2 Changing the Navigation Settings 

The Navigation settings of the instrument can be changed according to the requirements of the 
instrument.  

1. Refer to Figure 6-11. If required, select the CIS (Common Interrogate Signal) to enable it.  

2. From the drop down menu, select the required signal. 

Figure 6-11 – Enable the CIS 

 
 

3. If required select the Enable Responder. 
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4. Refer to Figure 6-12. Select the Turn Around Time from the drop down menu. 

Figure 6-12 – Turn Around Time 

 
 

5. Refer to Figure 6-13. Select the Wake-up Signal of W1 to W4 from the drop down menu. 

Figure 6-13 – Wake-up Signal 

 
 

6. Refer to Figure 6-14. The Wake-up Signals W3 and W4 are reserved for the BOP Controller. 
If these are selected a notification window will appear. 

Figure 6-14 – BOP Controller Warning 

 
 

7. If W3 or W4 are required click OK, if they are not required click Cancel and select a different 
Wake-up signal. 
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6.4.3 Changing the HPR Support 

1. Refer to Figure 6-15. If the HPR Channel is required, select Enable HPR Channel. The Set 
HPR button will appear. 

Figure 6-15 – Enable HPR Channel 

 
 

2. Refer to Figure 6-16. Selection of the Set HPR button will reveal the HPR Channel window. 

Figure 6-16 –HPR Channels 

 
 

3. Select the required HPR channel, then click OK. 

NOTES 

 Only HPR400 channels are supported. 

 The HPR should only be enabled if integrated with a third party system. For optimum 
performance of Sonardyne 6G instruments, HPR should be avoided. 
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4. Refer to Figure 6-17. Once the Enable HPR channel has been selected, the Permanently 
On option will default to On. 

Figure 6-17 – Permanently On. 

 
 

NOTE 

 The Permanently On option is defaulted to On to assist in communication with third 
party equipment. 

5. Refer to Figure 6-18. If the Permanently On option is deselected the instrument will sleep 
after 16 hours of inactivity. A warning window will appear to notify of this operation. 

Figure 6-18 – Notification of Sleep after 16 hours of Inactivity 

 
 

6. Click OK to confirm receipt of the notification, or click Cancel to return and enable the 
Permanently On option. 
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6.4.4 Selecting the Pulse Position Mode 

The Pulse Position Mode options are only available if the relevant sensors are fitted to the 
instrument. 

1. Refer to Figure 6-19. From the drop down menu, select the required sensor mode. 

Figure 6-19 – Pulse Position Mode Selection 

 
 

6.5 Changing the Instrument Address 

It is possible, if necessary, to change the address of an instrument by selecting the Set Address 
button – refer to Figure 6-20. 

Figure 6-20 – Set Address 
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1. Refer to Figure 6-21. Click the Set Address button. The Address Selector window will 
appear. 

Figure 6-21 – Address Selector Window 

 
 

2. Choose the new address according to the Wideband being used. Once selected click OK. 

3. Notification of the address change and the new address will now appear at the top of the 
screen –refer to Figure 6-22. 

Figure 6-22 – Address Set Notification 

 
 

6.6 Updating the Instrument Traffic Light Indicator 

Following any change made to the instrument configuration, the traffic light indicator will briefly turn 
red to indicate a change has been made to the 6G Configurator software but has not been 
transferred to the iWAND. After a short time the traffic light indicator will change to amber. This will 
indicate the changes made on the 6G Configurator software have been transferred to the iWAND 
but not to the instrument.  
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6.7 Clearing Configuration Changes 

Any changes made to the configuration of an instrument may be removed and the instrument 
returned it to its original configuration status. To clear the changes proceed as follows: 

1. Refer to Figure 6-23. Right click on the instrument in the history or asset listing and from the 
menu select Clear Changes. 

Figure 6-23 – Clear Changes 

 
 

2. The instrument will now return to the previous configuration setting before the changes were 
made. The traffic light indicator next to the instrument should now be showing green. 

6.8 Refreshing the 6G Configurator listing 

It may be necessary to disconnect the iWAND from the 6G Configurator software to allow it to 
gather more information from instruments. To refresh the 6G Configurator proceed as follows: 

1. If the iWAND is connected to the 6G Configurator using a serial or USB connection, 
disconnect the iWAND. If the iWAND is connected by Bluetooth no action is needed. 

2. Use the iWAND to gather information from the instruments – refer to the iWAND manual UM-
8315 for instructions. 

3. Once the information has been collected reconnect the iWAND to the PC if using a serial or 
USB connection. 
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4. On the 6G Configurator software, from the toolbar select Configuration > Refresh, or press 
the Refresh button. The iWAND will now refresh its connection with the 6G Configurator 
software and update the instrument listing with any new information. 

Figure 6-24 – Refresh 6G Configurator 

 
 

6.9 Test Report 

It is possible to produce a test report of any of the 6G instruments contained in the iWAND and 
displayed on the 6G Configurator software. 

NOTE 

 The 6G Configurator software will only produce a test report if  a green traffic light 
indicator is next to the instrument. 

To produce a test report proceed as follows: 

1. On the 6G Configurator software, select an instrument from either the History or the Asset list. 

2. Refer to Figure 6-25. Make sure the traffic light next to the instrument is indicating green. 

Figure 6-25 – Generate Test Report 
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3. Press the Generate Report button to create a two paged pdf report providing all information 
about the instrument. 

4. The first page of the report provides information specific to the instrument such as acoustic 
address, serial numbers and firmware versions etc.. It also lists any settings, battery status 
and sensor details – if fitted; and information of the iWAND that gathered the information. 

5. If the instrument has been successfully configured or tested a large green tick will appear in 
the top left hand corner of the first page. If the instrument has failed any tests then a large red 
cross would indicate the instrument requires investigation. 
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Figure 6-26 – Test Report 
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6.10 Exit the 6G Configurator Software 

When all activities have finished with the 6G Configurator software, and it is no longer required, to 
exit from the software proceed as follows: 

1. Refer to Figure 6-27. From the toolbar select File > Exit. 

Figure 6-27 – Exit 6G Configurator Software 

 
 

6.11 About the 6G Configurator Software 

Information about the 6G Configurator software can be found as follows: 

1. Refer to Figure 6-28. From the toolbar select Help > About. 

Figure 6-28 – About the 6G Configurator Software 
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2. An information screen will appear detailing all information about the version and date of the 
6G Configurator Software. 

Figure 6-29 – 6G Configurator Information 
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SECTION 7 – ADVANCED USER OPTIONS 

7. Manual Commands 
The following manual commands guidelines must only be used by Sonardyne Qualified Engineers, 
or under instruction from the Sonardyne Support Team.  

CAUTION 

 Using these instructions without the correct training or instruction could cause the 
iWAND to malfunction or cause damage to an instrument. 

Activating manual commands uses the iWAND outside its normal operational capabilities.  

7.1 Operating Manual Commands 

When using the iWAND in manual commands the acoustic transducer of the iWAND must maintain 
contact with the transducer of the instrument to enable communication. 

To activate manual commands proceed as follows: 

1. Select Configuration > Manual Commands from the main toolbar in the 6G Configurator 
software. 

Figure 7-1 – Activate Manual Command 

 
 

2. The manual commands screen will appear. Typing a command in the command bar then 
pressing Send will send a command to the instrument.  

Figure 7-2 – Sending a Manual Command 

 



 
Operation Manual for the iWAND 6G 
Configurator Software 

OM-8315 
Issue A Rev 0 

 

 

Section 7 
24 April 2013 38 

3. The command message and receipt will appear in the main screen. 

4. It is possible to disconnect from a port using the manual commands. To disconnect from the 
port select Connection > Disconnect. 

Figure 7-3 – Disconnect Manual Commands 

 
 

5. To exit Manual Commands click the ‘X’ at the top right of the screen. 
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SECTION 8 – FAULT FINDING 

8. Fault Finding 
If difficulties are encountered when using the iWAND it may be necessary to carry out fault finding. 
The following are possible faults and the actions to be taken. 

8.1 No Communication between the iWAND and the 6G Configurator 
Software 

If no communication is found between the iWAND and the 6G Configurator software proceed as 
follows: 

1. The iWAND is not connected to the 6G Configurator software if a red dot is displayed at the 
bottom left hand corner of the screen. 

Figure 8-1 – Connection Failed between iWAND and 6G Configurator Software 

 
 

2. In the 6G Configurator software toolbar select View > Show Comms View. 

Figure 8-2 – Show Comms View 
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3. The Comms View window will appear and show all communications between the iWAND and 
the 6G Configurator software. 

Figure 8-3 – View Comms screen 

 
 

4. If no communication is found between the iWAND and the software, check all connections if 
using the serial or USB connection method. If an attempt is made to connect using the 
iWAND and PC Bluetooth, make sure the iWAND Bluetooth is switched on (refer to the 
iWAND manual – UM-8315), and make sure the iWAND Belkon Bluetooth dongle is installed 
in the PC.  

5. Reboot the iWAND by switching the iWAND off, then back on again. 

6. If no solution is found for the failed connection contact Sonardyne Support Team. 
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GLOSSARY OF TERMS 

Term Definition 

Acoustic Responder An instrument that emits an acoustic signal in response to an 
electrical signal carried to it by cable. 

Acoustic Signal Information carried by sound pressure waves through water. The 
Sonardyne acoustic signal has a finite length. 

Acoustic Transceiver 

An instrument that emits and receives acoustic signals, and extracts 
information from them. Transceivers can measure the time it takes a 
signal to travel from its transducer to a transponder and return. Some 
can encode and send data in a message and extract digital data from 
a message (Acoustic Telemetry). Used on a surface vessel or to 
mark a point on the seabed, or fixed to a mobile for tracking or 
positioning. 

Acoustic Transducer A device that converts electrical signals into acoustic signals and vice 
versa. 

Acoustic Transponder An instrument that emits an acoustic signal when it detects an 
interrogating acoustic signal. 

Acoustic Transponder 
(Intelligent Transponder) 

A type of transponder that is managed by a micro-controller. 
Examples include the COMPATT (COMPuting And Telemetry 
Transponder) and the WMT (Wideband Mini Transponder). 
Depending on supported functionality it can:  
Decode acoustic telemetered commands from a transceiver and can 
send telemetered data to the transceiver. It can measure the 
distance between itself and other transponders and then telemeter 
the data to a transceiver. It can be capable of measuring its depth 
and the temperature of the water. 
It can be used to measure a variety of underwater parameters and 
telemeter these back to the surface. It can be used, as an intelligent 
angle-measuring device, in a Riser Angle Monitoring System. 
It can be fitted with a release mechanism so it can return, on 
command, back to the surface e.g. if battery power is low. 

CIS 

Common Interrogation Signal. Multiple transponders can be set to 
reply to a single common interrogation signal - this can increase the 
efficiency of tracking operations as it reduces the number of acoustic 
interrogations in the water. When transponders are set to respond to 
a common interrogate signal they will respond on their Individual 
Reply Signal. 

COMPATT COMPuting and Telemetry Transponder (see Acoustic Intelligent 
Transponder) 

CPU Central Processing Unit 

DAS A micro-controlled data acquisition and logging sub-assembly located 
within a transponder. 
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Term Definition 

Delay between commands Provides a delay between adjacent commands.  

Firmware 
The firmware installed on the transponder. Firmware upgrades can 
be installed via WSM Terminal. The Tx firmware refers to the 
transmission signal synthesiser. 

Global Positioning System 
(GPS) 

A multi-user, 24-hour, worldwide radio navigation system using the 
NAVSTAR constellation of satellites. GPS receivers are capable of 
tracking and decoding data from the satellites and using it to 
compute the position and velocity of a vehicle.  

HPR 

Hydroacoustic Position Reference. System comprising both a 
transmitter (transducer) and a receiver (transponder). A signal 
(pulse) is sent from the transducer, and is aimed towards the seabed 
transponder. This pulse activates the transponder, which responds 
immediately to the vessel transducer. The transducer, with 
corresponding electronics, calculates an accurate position of the 
transponder relative to the vessel. 

Long Base Line Positioning 
System (LBL) 

A system where two or more transponders are on the seabed. The 
positions of the transponders are established by a calibration process 
in a seabed frame. The distances from a transducer to each 
transponder are measured using a transceiver. The position of the 
transducer can be computed in the seabed frame. The name comes 
from the “baselines” joining each transponder.  

LUSBL Long and Ultra Short Base-Line. A hybrid of an LBL and USBL 
system. It utilises USBL equipment in an LBL configuration. 

Serial Communications 
Wait 

The maximum time allowed for the Transponder to reply to an RS232 
command. 

SSM Super Sub-Mini Transponder (WSM predecessor) 

UID Unique Identification number. It is the unique identification of the 
instrument and is electronically coded into the instrument firmware. 

Ultra Short Base Line 
Positioning System (USBL\) 

A system similar to an SBL system except the system uses three or 
more elements in a single transducer array. The measurements it 
makes are the differences in “time-phase” of the signals from each 
element. The co-ordinate frame is fixed to the transducer array which 
must be oriented in the vessel frame to be equivalent to the SBL. 
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